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INTRODUCTION

Introduction

Welcome to the Enhanced Customer Statement module, a powerful
companion product for Microsoft Dynamics GP.

Enhanced Customer Statement provides the following features and
benefits not available with standard Microsoft Dynamics GP customer
statements:

True Balance Forward—The balance at the start of the period will
always match what was reported at the end of the last period similar
to credit card and bank statements. Enhanced Customer Statement
correctly handles credits applied from the work file, or from a period
after the statement cut-off date by backing them out of the statement
reporting file and readjusting the aging buckets. Enhanced Customer
Statement also adjusts for write-offs and trade discounts occurring in
periods after the statement cut-off date.

Include totals in header for total invoices, total payments, total credits,
total finance charges, total returns and total other charges within
statement period—this is also similar to the type of statements credit
card companies send.

Show invoice detail—Enhanced Customer Statements will include line
item detail from invoices generated by the Invoicing or Sales Order
Processing modules. It also has optional features for displaying serial
numbers and kit components.

Multiple Statement printing—print copies of the same statement to
send to different addresses.

Enhanced descriptions for unapplied credit transactions.

Enhanced descriptions for voided, waived and NSF transactions.
Prints check numbers on the statement instead of payment numbers.
Every statement will print in one and only one of the following five
categories: Current Due, Past Due, Credit Due, Zero balance with
activity during period and No Activity. Statements may easily be
divided into these five groups for printing with different statement
messages configured for each group.

Archive statements for reprinting at a future date.

Option for printing Summary Invoices.

Optional ability to age unapplied credits.
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Enhanced Customer Statement is particularly useful for companies that
use statements to bill their customers, such as:

e Private schools that use the statements to bill parents for the books
and other supplies their students purchase each month, as well as the
school tuition.

e Health clubs that allow their patrons to run a tab at their golf shop or
restaurant and be billed by statement at the end of the month.

e Companies that want to give their customers a clear monthly report

for invoice and payment reconciliation, like banks and credit card
companies do.

ENHANCED CUSTOMER STATEMENT
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INTRODUCTION

What’s In This Manual?

This manual contains a detailed description of Enhanced Customer
Statement including step-by-step instructions to guide you through the
installation, registration and setup of your Enhanced Customer Statement
module, and instructions for producing enhanced customer statements for
your customers.

This manual assumes that you are familiar with navigation principles in
Microsoft Dynamics GP and that you know how to operate the Microsoft
Dynamics GP accounting system. It also assumes that Microsoft Dynamics
GP has been installed and configured on your computer.

This manual contains the following chapters:

The Introduction chapter lists the benefits and features of Enhanced
Customer Statement.

The Installation & Setup chapter has step-by-step instructions that guide
you through the installation, registration and setup of your Enhanced
Customer Statement module.

The Using Enhanced Customer Statement chapter describes how to
preview and print statement details, print summary invoices, and multiple
copies of statements.

The Modifying Statements in Report Writer chapter describes how to
customize your statements in Report Writer.

Appendix A: Data Tables lists all the tables created in Enhanced Customer
Statement and their descriptions.
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Symbols and conventions

This manual uses the following symbols and conventions to make

information stand out.

Symbol/Convention

Description

A

The warning symbol indicates situations you should be

especially aware of when completing tasks. Typically, this
symbol includes cautions about performing steps in their

proper order, or important reminders about how other
information in Microsoft Dynamics GP may be affected.

'l

The light bulb symbol indicates helpful tips, shortcuts
and suggestions.

File >> Print

The ( >>) symbol indicates selections to make from a

menu. In this example, from the File menu, choose Print.

ENHANCED CUSTOMER STATEMENT
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Additional resources

Documentation is provided in online or hard copy format as an Adobe
Acrobat PDF file. Online help is available in this version of Enhanced
Customer Statement. Press F1 or click the help icon to obtain online help
for the window you have opened.

To obtain product support services:

Please refer to this quick reference table when you need to use Encore’s
Technical Support services.

Service Contact
General Calls (204) 989-4330
Toll-Free (888) 898-4330
(North America only)
Fax (204) 235-2331
E-mail support@encorebusiness.com
Web http://www.encorebusiness.com/

Before You Call Support
You should have the answers for all of the following questions to help your

support specialist quickly narrow down the source of the problem you are
experiencing.
e What is the exact error message?

e When did the error first occur?

¢ What task were you attempting to perform at the time you
received the error message?

e Has the task been completed successfully in the past?
e What is the name of the window you are working in?
¢ What have you done so far to attempt to fix the problem?

e Have you performed any of the table maintenance procedures
such as check links?

¢ If have performed table maintenance procedures and received
error messages, what kind of messages?

¢ Does the problem occur in another company?

e Does the problem occur on another workstation?
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e Does the problem occur for more than one user?

e Have you imported any data?
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1 INSTALLATION

Chapter 1: Installation

For information on the
data tables installed for
Enhanced Customer
Statement, refer to
Appendix A, “Data
tables,”

This chapter describes how to install and register Enhanced Customer
Statement.

This chapter contains the following sections:

Upgrading from previous versions
Installing Enhanced Customer Statement
Entering registration keys

Creating tables
Setting up an archival document number

Upgrading from previous versions

If you are upgrading from a prior version of Enhanced Customer
Statement, be sure to back up your data first, and then complete the
installation, registration and setup procedures described in this manual.

Installing Enhanced Customer Statement

Before you begin installing Enhanced Customer Statement, do the
following:

Note the directory location of your Microsoft Dynamics GP installation.
You will need this information during the installation.

Verify that the ECS.exe file has been downloaded to your computer.
Create a backup of your Microsoft Dynamics GP data before installing.

Exit all applications.

To install Enhanced Customer Statement:

1.

Log in as an administrator on your workstation.

Open Windows Explorer and locate the ECS.exe file. The location of
this file will vary depending on how you acquired the application.

Launch the ECS.exe file by double-clicking it. The installation program
for Enhanced Customer Statement will start.

Follow the instructions in each window.

Start Microsoft Dynamics GP. You will receive the following message
box.
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Dexterity Runtime

e ) Mew code must be included in the :Z:FProgram FilesiMicrosoft
! / Dynamics/GP201 3/DyMNAMICS set dictionary. Do you wish to
include new code now?

6. Select Yes. Information for Enhanced Customer Statement and Encore
Product Registration will be included in the Dynamics.set file.
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Entering registration keys

Before you can use Enhanced Customer Statement with your company
data, you must register your software. To register your software enter the
product registration key provided to you by Encore. If you choose not to
enter the registration information, you will only be able to create sample
transactions using Fabrikam Inc—the lesson company.

To register the product:

1. Open the Encore Product Registration window.
(Microsoft Dynamics GP Menu >> Tools >> Setup >> System >> Encore
Product Registration)

2. Select the product you wish to register.

B Encore Product Registration [Z]|E|g|
File Edit Tools Help Debug sa Fabrikam, Inc, 4/12/2017
v 0K
Site [ Previewkeps

“F'Iatform Microsoft Dynamics GP 11.00

Wiew By All Products

|Products Vesion

Enhance er State
EGST PST Distribution

@ EPM:11.00.02.039
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3. Choose the show detail expansion button to display the detailed view
of the registration window.

B Encore Product Registration

File Edit Tools Help Debug sa Fabrikam, Inc, 4/12/2017
v k|
Site Previewkeys
Users 10 Compary | Fabrikam, Inc.
D atabase SOL Server |
Flatform Microzoft Dynamics GP 11.00 |
Wiew By All Products -
Products Wersion
Enhanced Customer Statement 1.003
Praduct ID e
Product Key g T e T e e

Statuz Wﬁegistéred ;
About Support Froduct Website  Check for updates

@ EPH:11.00.02.039

4. Enter the product registration key provided by Encore.
5. Select the About zoom field to open the About window for this
product. This window contains the version number for this product

and information on how to contact Encore.

6. Select OK to close the window.
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For more information
about statement
archives, see Reprinting
statements and archives
on page 33.

Creating tables

Whether you want to demo or run the product, you must run the Table
Conversion/Upgrade process to create tables—this will set up SQL
components and convert any existing data.

'l

You must log in as System Administrator to run the Table Conversion/Upgrade

process.

To create tables

1.

'l

Setting up an archival document number

Open the Table Conversion window.
(Microsoft Dynamics GP Menu >> Maintenance >> Enhanced Customer
Statement >> Table Conversion)

B Table Conversion

File  Edit Tools Help sa Fabrikam, Inc. 4f12/2017

Enhanced Customer Statement T able Conversion / Upgrade

@ % Process ° Cancel

Select Process. Tables will be created, permissions will be set, and
existing data will be converted.

Every time you install Enhanced Customer Statement, you must run the table
conversion/upgrade process.

Enhanced Customer Statement automatically assigns archival document
numbers starting with 00000000001. If you want to add some initial
characters or want to start the numbering at a particular number, you can
do this in the Enhanced Statement Setup window.

To set up an archival document number:

1.

Open the Enhanced Statement Setup window.
(Microsoft Dynamics GP Menu >> Tools >> Setup >> Sales >>
Enhanced Customer Statement)

™ Enhanced Statement Setup

File  Edit  Tools Help sa Fabrikam, Inc, #4/12/2017
Mest Archival Document Mumber |
®
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1 INSTALLATION
2. Enter the number that you want to use as the starting point for your
archived document numbers.

3. Select OK to save your entry.
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Chapter 2: Using Enhanced Customer Statement

This chapter explains how to use Enhanced Customer Statement to
produce true balance forward statements for your customers. It includes
the following topics:

e Previewing and printing summary statement details

e Excluding documents from the summary invoice

e Accessing summary invoice transactions when applying cash receipts
e Summarizing item detail lines in different ways

e Printing multiple statements

e Displaying split tax details in statements

e Reprinting statements and archives

Enhanced Customer Statement keeps payments after the statement cutoff
date from reporting on the statement even if they have been applied to
invoices from the prior (balance forward) periods. On the Microsoft
Dynamics GP statements, payments applied to a previous period reduce
the amount shown as balance forward and the payment does not show up
on the statement.

Microsoft Dynamics GP statements only have a correct running balance if
applied payments are shown. In Enhanced Customer Statement, the
running balance will be correct even without showing the applied
payments.

Enhanced Customer Statement does not include the Microsoft Dynamics
GP drop-down option called Exclude fully applied payments because you
cannot both exclude a fully applied payment and maintain a correct
running balance.

Previewing and printing summary statement details

When you print summary statements, the details of the statement that
you printed are logged in the statement archive. In order to avoid adding
to the archive when you simply want to test your statement options,
choose Preview instead of Print. Using Preview does not commit the
summary statements to the archive whereas Print does. For more
information about accessing the statement archive to reprint statements
at a later date, see Reprinting statements and archives on page 33.
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There are two ways to show the invoice detail for statements:

e Mark the Include Details check box OR

e Enter the letters DS as the first two letters in the Statement ID field

When you choose to show line item details, you can determine how many

of the extra fields will show on the invoice. The chapter Modifying

Statements in Report Writer explains how to change the positioning of

these fields on your statement report.

'l

We recommend that you run the Receivables Aging process (Microsoft
Dynamics GP >> Tools >> Routines >> Sales >> Aging) using the statement

cutoff date as the aging date before you print statements.

To preview or print statement details:

1. Open the Enhanced Statements -Print Receivables window.
(Microsoft Dynamics GP Menu >> Tools >> Routines >> Sales >>

Enhanced Customer Statement)

B Enhanced Statements - Print Receivables Q@@

File  Edt Tools Options  Help

I Save | & Clear | X Delete @Preview =

Statement 10 | ||| Description

Form: Long Form | DatetoPrint  |Enter Date
Customers: by Customer 1D v Summarize to | Enter Date
Daocuments: by Document Mumber ~ Cut-0Ff Date Enter Date
Last Frinted: Options:

Addiess 10 Y

[ Include Details
Print For:

] Summary Irvoice

NnAcIlleE
Include Type:
@ Al
() Dpen ltem
Print: (@) Statements () Alignment Form O Balance Forward
Ranges by Customer 1D | @ al O From
Restrictions:
14 4 » #l|byStatement ID e

sa Fabrikam, Inc, 4/12/2017

w 4M202Mm7 =
v =
~ =

[ Show &pplied Payments
[ Omit WaivedA/oided ltems
[ Hide Kit Components

[] Show Line Item Sales Tax
[ age Unapplied Credits

Frint

Credit Limits
Finance Charge
Paymert Terms
Meszages

Walidate

e

2. Enter or select a Statement ID.

3. Enter a description (optional).

4. Select a form to print your statements on—long form, short form, side

form, serial number form, or tear-off form.

To display serial numbers for ordered items on your statements,

choose the Serial Number Form.
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10.

11.

12.

13.

14,

15.

16.

From the Customers drop-down menu, select the order in which to
print the customer statements.

From the Documents drop-down list, select a method for listing
documents for each customer on the statement.

We recommend sorting statement transactions by transaction date.

Select the customer groups that should receive statements (in the
Print For list box).

We recommend selecting all options except No Activity.

To print an alignment form to verify that the forms are positioned
correctly in the printer, mark Alignment Form.

To print the actual statements, mark Statements.
Select a date to print the statement.

To summarize transactions before a particular date, select a date in
the Summarize to field. All transactions on or before this date will be
summarized, and a total balance for those transactions will be
displayed. Transactions after this date will be displayed in detail.

We recommend running statements using a Summarize to date and a Cut-off
date.

Select a cutoff date to print statements for transactions through the
specified date.

Enter or select the address ID for your company’s address to appear on
the statement.

To show expanded invoice detail on the statements, mark the Include
Details check box. If you want to show expanded detail but not kit
details, mark the Hide Kit Components check box.

To show quantity, unit of measure, and unit price on the statement
report, mark the Include Qty check box—Enhanced Customer
Statement will create a second line for each invoice line item. The
Include Details check box must be marked in order to mark the Include
Qty check box. You can also modify the statement report to include
extra fields using Report Writer.

To print statements without showing payments or balance forwards,
mark the Summary Invoice check box.

When the Summary Invoice check box is marked, the system prints
statements without showing payments or balance forwards. When

ENHANCED CUSTOMER STATEMENT
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D) D)

18.

19.

20.

21.

2 USING ENHANCED CUSTOMER STATEMENT

both the Summary Invoice check box and the Include Details check box
are marked, one comprehensive summary invoice is created
eliminating the need for many individual invoices.

When you print a summary invoice, Enhanced Customer Statement
will add an archival number to the statement which may be used as a
unique summary invoice number. It will also allow you to reprint the
summary invoice, if necessary. For more information about archives
and reprinting statements, see Reprinting statements and archives on
page 33.

If you print a statement mid-month by mistake when the statement should
have been printed at the end of the month, you will have to reprint the initial
portion of the statement from the archives since those transactions, once
printed, are no longer available.

You can now include split tax details on a summary invoice without
marking the Include Details option. The split tax details are shown per
invoice not per line item. See Displaying split tax details in statements
on page 32 for more information

Mark any of the options that apply.
We recommend that you leave Show Applied Payments unmarked.

To keep invoices or payments that have been waived or voided from
appearing on the statement report, mark the Omit Waived/Voided Items
option.

Mark the account types to include—all accounts, open item accounts,
or balance forward accounts.

Mark the information to print on the statements—credit limits,
payment terms, finance charges, and messages. If you're using
national accounts, you also can include individual child statements.

To create a message, choose Messages to open the Sales Statement
Message Entry window.

Using this window, you can enter your own message. Each of the
situations in the description column can have its own message and is
printed on any statement where that situation occurs. Select OK to
close the window when you finish.

Select a range of customers to print statements for and choose Insert;
the range restriction is displayed in the Restrictions list.

You can enter only one restriction for each restriction type. For

example, if you enter a restriction specifying that only customer IDs
100 through 300 should be printed, you can’t enter another restriction

ENHANCED CUSTOMER STATEMENT 25


[ /CropBox [0 144 558 783] /PAGE


2 USING ENHANCED CUSTOMER STATEMENT

for customer IDs 500 through 800. To print multiple ranges of
customer records, you must print each range separately.

If you're printing statements for national account customers, the
parent customer ID must be in the range selected for either
consolidated or individual national account statements to print.

choose Preview—the statement will not be committed to the statement
archive until you print it.

@ To test your statement options and preview what the report will look like,

22. Select Save to save the statement ID selections for future printing, or
choose Print to print the statements immediately .
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Excluding documents from the summary invoice

Prior to printing summary invoices, you may exclude any open document

from printing on the invoice.

To exclude documents from the summary invoice:

1. Open the Enhanced Customer Statement window.
(Microsoft Dynamics GP Menu >> Tools >> Routines >> Sales >>
Enhanced Customer Statement)

2. Go to the Options menu
(Options >> Exclude Invoices.)

CEX

sa Fabrikam, Inc, 4/12/2017

B Enhanced Statements - Print Receivables

File  Edit

= -F |@ Cle
Create Summary Options

Statement 1D y .
Split Tax Details
Farm: Long Farm ¥ DatetoPint |EnterDate v |42ty

S0 Ll ¥

Toals

Chr+E

Chrl+s —

3. The Exclude Open Documents window will open.

B Exclude Open Documents

File  Edit Tools Help sa Fabrikam, Inc. 4/12/2017
v’ ok | =)

Custarner Number AARONFITOOM 9]

Customer Mame: | Aaron Fitz Electical

Dacument Mumber Tupe Date Current Trs Amount Excluded

DM20005 Dbt Memos 142772014 $250000) ) ~

FC20010 Finance Charges 1423/24 $20.00 [

INW53008 Sales / Invoices 9/6/2m8 $93883 [

RTM20015 Returnz 1/23/204 $256800 [

SALES 00000001000 Sales / Invoices B/a/2m7 000 [ L3

SALES00000001003 Sales / Invoices 412/2m7 w7l O

sLs11012 Sales / Invoices 1/21/2m4 224370 [0

5L511015 Sales / Invoices 1/27/204 $83333) [

SLS11018 Sales / Invoices 1/30/2014 $8.00000) [

5L520000 Sales / Invoices 1/27/204 $2461.000 [

STDINV2044 Sales / Invoices 2/7/206 0| [

STDINV2057 Sales / Invoices 2/19/206 00| [

STDINV2038 Sales / Invoices 2/19/206 000 [

STDINYV2089 Sales / Invoices 2/25/26 000 [ La

LRI @

Enter or select a customer.

Mark the Excluded check box next to any documents that you wish to
exclude.

Payments do not appear on this list because they are automatically excluded.

Select OK. Repeat steps 3 — 5 as required.
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See the Microsoft
Dynamics GP
Receivables
Management
documentation for
more information
about applying cash
receipts.

Accessing summary invoice transactions when applying cash

receipts

When customers pay a summary invoice, they often reference the
summary invoice on their checks instead of the individual document
numbers. Applying the cash receipt to the correct invoice can be
complicated. Enhanced Customer Statement provides a lookup where all
open documents for the customer are displayed by their summary invoice
number making it easier for you to apply the cash receipt to the correct
invoice.

To access the summary invoice transactions when
applying cash receipts:

1.

5.

Open the Apply Sales Document window.
(Transactions >> Sales >> Apply Sales Document)

Enter or select the Customer ID.
Open the Summary Invoice Lookup window.

Go to the Additional menu
(Additional >> Summary Invoice Transactions or CTRL +S)

B Apply Sales Documents

File Edit Tools Bl Help sa Fabrikam, Inc, 4/12/2017

/ akK dh  Fir Summary Invoice Transactions Chrl+5 ¢ ~
Customer [D i Mame
Type: Papments hd Apply From Curency D
[P Mo 4 [N [T I = enni Y
& >

The Lookup Summary Invoices window will open.
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m Lookup Summary Invoices E“E‘@

File:  Edit Tools Help sa Fabrikam, Inc, 4/12/2017

Sor By | Summary Invoice Number hd

Custamner Mumber AARONFITO001

Custamer Mame Aaron Fitz Electrical

Surmary |nvaice Mumber Diocument Mumber Tupe Date Arnount
S
v
@

6. After a summary invoice is printed, all open documents for the
customer will be displayed by their summary invoice number.

7. Select OK to close the window.

Summarizing item detail lines in different ways

You can choose to have some items appear in detail on your statement
and indicate that other items should be summarized. Item detail lines can
be summarized in the following three ways:

e Statement Summary—If an item is marked to be included as a
statement summary, then it will be totalled with all other items
marked in a similar way. The total line will appear on the statement
immediately after the balance forward line.

¢ |tem Class Summary—If an item is marked to be included as an item
class summary, then it will be totalled with all items in its class that are
marked with item class summary. The total line will appear on the
statement immediately after any statement summary lines.

e |tem Summary—If an item is marked to be included in an item
summary, then it will be totalled with any other of the same item
appearing on any invoice in the statement. The total line will appear
on the statement immediately after any Item Class summary lines.

Because the summary option setup is linked to your report option, you can

have different methods of summarizing for different statement report
options.

ENHANCED CUSTOMER STATEMENT 29
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To summarize statement lines:
1. Open the Print Receivables Statements window.

(Microsoft Dynamics GP Menu >> Tools >> Routines >> Sales >>
Enhanced Customer Statement)
2. Enter or select a Statement ID.

3. Open the Statement Summary Options window.

4. Go to the Options menu.
(Options >> Create Summary Options)

B Statement Summary Options E]|§|@

File  Edit Tools  Options  Help sa Fabrikam, Inc, 4/12/2017
Statement 10 TEST
Item Mumber |Q| Summary kethod
Item Description
100 L5] |Item Summary hltad
Green Phone
| v
v
Meszages
©

5. Select the item and select a summary option. Tab to the next line and
repeat until you have selected all the items that you want to
summarize.
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6. To specify the descriptions that will display on your statement beside
these items, choose the Messages button. The Statement Summary
Messages window will open for you to enter the message.

B Statement Summary Messages E]|E|@
File  Edit  Toaols  Options  Help sa Fabrikam, Inc, 4/12/2017
Statement [D TEST
Drescription Meszage
100:LG Green Phone -
-
@

If any of the Invoicing or Sales Order Processing invoices containing
summary line items have line item sales tax, then the amount of the
tax will be included with the summary and deducted from the rest of
the invoice.

7. Select OK to close the page.

Freight and miscellaneous charges
Invoices containing freight and miscellaneous charges will still be
displayed in detail. If you want freight and miscellaneous charges
summarized, you have a couple of options:

e Use a calculated field in Report Writer to restrict lines containing
freight and miscellaneous charges, that is, omit the body if it
would contain a freight or miscellaneous charge. Use the freight
and miscellaneous summary buckets to print totals at the bottom
of the report.

e Define line items for freight and miscellaneous instead of using the
Freight and Miscellaneous fields in Invoicing or Sales Order
Processing and include the line items in the statement summary
setup.

Printing multiple statements

Enhanced Customer Statement allows you to print multiple copies of a
statement when necessary. For example, a school may want to send copies
of a statement to the student and to each of the student’s parents. In
order to print multiple statements, you must create multiple addresses
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starting with the letters STMT in the Customer Address Maintenance
window. Enhanced Customer Statement will send statements to the
primary address and any additional STMT addresses.

To print multiple statement copies:

1. Open the Customer Address Maintenance window.
(Cards >> Sales >> Addresses)

2. Enter or select the Customer ID.

3. If a primary address doesn’t exist, enter the primary address and
choose Save.

4. Enter any additional addresses to which you want to send statements,
using the letters STMT to begin the Address ID. The word “Duplicate”
will appear on any additional statements printed.

5. Enter the address information.

6. Select Save to save your entries.

Displaying split tax details in statements

Using Enhanced Customer Statement, you can break out tax detail
information and show it in separate columns. You also can use the Tax
Detail IDs on your invoice documents to capture extra information about
particular charges unrelated to actual taxes. For example, you can use a
Tax Detail ID for a 10% service charge.

Please note that Enhanced Customer Statement only supports split taxes for
non-kit line items. It does not support split taxes for returns or credits or taxes
included in trade discount, freight, or miscellaneous.

To display split tax details in statements:

1. Open the Print Receivables Statement window.
(Microsoft Dynamics GP Menu >> Tools >> Routines >> Sales >>
Enhanced Customer Statement)

2. Enter a Statement ID.

3. Open the Split Tax Details Option window.
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4. Go to the Options menu.
(Options >> Split Tax Details)

Bl Split Tax Detail Options =3
File Edt Tools Options  Help #1zfz017 7
Statement [D TEST

First Taw Detail Column ISASTE-PSEND (i

Second Tax Detail Column ISEXMT +PSONL |22

Third T ax Detail Column LISIMPRT+Dal 21 |
@ ‘/ oK

5. Mark the Split Tax Details check box. If you haven’t marked the Include
Details check box on the Print Receivables Statement window,
Enhanced Customer Statement will mark it for you.

6. Select the tax detail columns that you want to summarize. You can
choose up to three columns. Any additional tax items will be
summarized in the ME_Tax_Detail_Bucket[4] which will contain all
remaining tax information.

To save the changes made in this window you must select Save in the
Enhanced Statements - Print Receivables window.

7. After setting up the statement options, you must modify a statement
report in Report Writer to create columns to show the tax summaries.
Add the tax summaries to the file called BU RM Statements
Transactions Temporary file. There are four summary totals for the tax
details: ME_Tax_Detail_Bucket [1] through ME_Tax_Detail_Bucket[4].
Drag the tax buckets that you want to see onto your report and
position them as desired.

Note that the tax computations will only show on the first line of a
multi-line invoice. To prevent seeing $0.00 values for taxes on
secondary lines for multi-line invoices, double-click each
ME_Tax_Bucket field on the report to open the Report Field Options
window and select the display option Hide when empty.

8. After making these changes to your report, follow the directions in
Setting security access for modified reports on page 42 to set security
options on your modified statement report.

Reprinting statements and archives

Normally, when you print a statement, it is not possible to reprint a
statement after the fact and see the same data that was on the original
statement because the open items get cleared out of the Receivables open
file. However, Enhanced Customer Statement saves the data printed each
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time you print statements. Using the archival system, you can look up all
the statements generated by the system—by customer, statement
(customer) name, archival number or statement date—and reprint the
statements.

The archival process assigns a unique archival number to the statement.
You can specify the starting archival number if you wish, see Setting up an
archival document number on page 18 for more information. If you want
your customers to see the archival number, you can add it to the
statement report using Report Writer.

To reprint statements from the archives:

1. Open the Enhanced Statements - Reprint window.
(Microsoft Dynamics GP Menu >> Tools >> Routines >> Sales >>
Reprint Enhanced Statement)

B Enhanced Statements - Reprint [’._l['gl[zl
File  Edit Tools Help sa Fabrikam, Inc, 4/12/2017
/ ()8 |@ Reprint | Reprint R ange | Hedispla_lgl
Customer Mumnber From |Q| To |Q|
Statement Mame From To
Statement D ate From E |Te 4
Archival Mumber From To
Farm to Reprint on Lona Form v |
Customer Mumber Statement Mame Statement Archive Mumber Date
A~
v
|Eust0mer MHumber v | @

2. To reprint a single statement, highlight the statement and choose
Reprint. To reprint a range of statements, enter any of the available
ranges and choose Redisplay, then select Reprint Range.

Summary invoices can only be reprinted from the Enhanced Statements -
Reprint window.

3. Select OK to close the window.
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Chapter 3: Modifying Statements in Report Writer

36

This chapter describes how to customize reports in Report Writer. It
includes the following topics:

e QOpening the statement report in Report Writer

e Displaying quantities in statement reports without decimals
e Adding a running balance to the statement

e Adding optional total fields for Payments, Credits, Returns

e Adding your company address to the statement

e Converting numerical dates to the format Period: <month>
e Adding calculated fields to your report

e Setting security access for modified reports

Opening the statement report in Report Writer
This section explains how to open a statement report in Report Writer.

To open the statement report in Report Writer:

1. Open Report Writer.
(Microsoft Dynamics GP Menu >> Tools >> Customize >> Report
Writer)

2. Select Enhanced Customer Statement as the product.

Microsoft Dynamics GP

Product:

QK | Lancel |

3. Choose reports. Choose one of the following reports from the Original

Reports list:

e BU RM Statement Long Form—default long form without any
modifications

e BU RM Statement Short Form—second default long form without
any modifications

e BU RM Statement Side Form—modified to include formatted
quantities

e BU RM Statement Serial Number Form—modified to include serial
numbers on the statement form

e BU RM Statement Tear-Off Form

4. Choose Insert to modify the report.

5. Choose Open. The Report Definition window will open.
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6. Select Layout. The Report Layout window will open.

Displaying quantities in statement reports without
decimals

If you’re using the Qty field as a separate field in your report, it will
normally display with two decimal places. The following procedure
explains how to remove the decimals.

Quantity, unit of measure and unit price can be included in your statements
automatically by marking the Include Qty check box in the Print Receivables
Statements window.

To remove the decimals from the Qty field:

1. Open the statement report that you wish to modify. See Opening the
statement report in Report Writer on page 36.

2. Locate the Qty field on the report and double-click on it. The Report
Field Options window will open.

3. Choose the E]button to the right of the Format field. The Format
Lookup window will open.

4. Choose New. The Format Definition window will open.

5. Enter the format name QTY.

6. Choose Right from the alignment drop-down list.

7. Choose Space from the Fill drop-down list.

8. Enter O (zero) in the Decimal Digits field.

9. Choose System from the Negative Symbol drop-down list.
10. Mark the Show Thousands Separator option.

11. Choose OK three times to assign the new format to the Qty field.

Adding a running balance to the statement

If you would like your customers to see a running balance on their
statements, you can add the field called BU_Running_Balance, created by
Enhanced Customer Statement, into the body of the statement report.
Report Writer’s Running Sum feature doesn’t reset the balance between
customers.
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To add a running balance to the statement:

1. Open the statement report in Report Writer. (complete the procedure
To open the statement report in Report Writer: on page 36).

2. Open the Toolbox if it isn’t already open.
(Layout >> Toolbox)

3. Inthe toolbox, select BU RM Statements Transactions Temporary from
the drop-down menu.

4. Select the BU_Running_Balance field and drag it into the body of your
statement.

When the balance hasn’t changed since the last reported balance, the running
balance is set to zero.

5. To prevent zero balances being printed, double-click the field after you
drag it into the report and select the Hide When Empty display option.

Adding optional total fields for Payments, Credits,
Returns

Some optional total fields have been added to the Statement Header file.
You can add these fields to your statement report using Report Writer to
show total invoices, finance charges, payments, credits, returns for all the
items on the statement occurring between your Summarize to date and
your Cut-off date.

To add optional total fields:

1. Open the statement report in Report Writer. (complete the procedure
To open the statement report in Report Writer: on page 36).

2. Open the Toolbox if it isn’t already open.
(Layout >> Toolbox)

3. Inthe toolbox, select BU RM Statements Header from the drop-down
menu.

4. Dragthe BU_Total fields that you want into your statement header or
footer, for example, BU_Total Payments.

@ If you want to combine some fields, such as returns and credit memos, use the
calculated fields feature.

Adding your company address to the statement

If you’re not using pre-printed statement forms, you may want to add your
company address to the statement header.
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To add your company address to the statement:

1.

Open the Print Receivables Statements window.
(Microsoft Dynamics GP Menu >> Tools >> Routines >> Sales >>
Enhanced Customer Statement)

Enter the Address ID field choosing the company address that you
want to use.

Open the statement report in Report Writer (Opening the statement
report in Report Writer on page 36).

In the toolbox, select Company Location Master from the drop-down
list.

Drag any or all of the address fields into your report header as desired.

Converting numerical dates to the format Period:
<month>

To make it easier to print the dates in word form on the reports, Enhanced
Customer Statement has added a Report Writer function called
rw_Month_Words. Using this function will allow you to convert dates on
the form to the following format: Period: January

To convert numerical dates to the format Period: <month>:

1.

Open the statement report in Report Writer. (complete the procedure
To open the statement report in Report Writer: on page 36).

Open the Toolbox if it isn’t already open.

(Layout >> Toolbox)

Select Calculated Fields from the drop-down menu.

Choose New. The Calculated Field Definition window will open.

Enter Document Period as the name.

Choose String from the Type drop-down list.

Choose the Constants tab.

Choose String from the Type drop-down list.

In the Constant field, enter the word Period followed by a colon : and a

space < >.
The expression result will be “Period: “

10. Select Add.
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To add the month as a word:

1.
2.

10.

11.

12.

13.

14.

Choose the CAT button to append to the string field.
Choose the Functions tab.

Mark the User-Defined radio button.

Choose System from the Core drop-down list.

Choose rw_Month_Words from the Function drop-down list.

Select Add.

Choose the Fields tab.

From the Resources drop-down list, choose a file that includes the field
you wish to add, for example: BU RM Statements Transactions

Temporary

From the Field drop-down menu, choose the date you want to modify,
for example, Document Date.

Select Add.

Choose the Constants tab.

Choose Add.

Select OK to close the Calculated Field Definition window.

Drag the calculated field onto your report.
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Adding calculated fields to your report

To make it easier for you to include calculated fields, such as the summary

invoice number, Sales Order Processing user-defined fields, and the

markdown amount, on your Microsoft Dynamics GP reports, Enhanced

Customer Statement has added functions for the following fields:

e Sales Order Processing user-defined fields
e Summary Invoice Number

¢ Markdown amount—for line with line items not the extra quantity

lines

@ A calculated field named markdown already exists in the Long Form.

The following table lists the available functions, and the resource files and
fields applicable to each function. Refer to this chart as you complete the

To add calculated fields to a report: procedure.

Function: Resource Field

SOP User-Defined Fields

rw_SOP_User_Defined_1 BU RM Statements SOP Number AND
rw_SOP_User_Defined_2 Transactions Temporary SOP Type

rw_SOP_User_Defined_3
rw_SOP_User_Defined_4
rw_SOP_User_Defined_5
rw_SOP_User_Defined_Table_1
rw_SOP_User_Defined_Table_2
rw_SOP_User_Defined_Table_3
rw_SOP_User_Defined_Date_1
rw_SOP_User_Defined_Date_2

rw_Summary_Invoice_Number BU RM Statements Document Number AND
Transactions Temporary RM_Document Type-All
rw_SOP_Markdown BU RM Statements Iltem Number
Transactions Temporary
Sales Transaction Amounts Markdown Amount
History

For the Sales Order Processing user-defined fields to display on the report, you
@ must choose Include Details in the Print Receivables Statements window.
However, if both the Include Details and Include Qty options are marked when
you add these calculated fields, the user-defined fields may print multiple
times.

To add calculated fields to a report:

1. Open the statement report in Report Writer. (complete the procedure
To open the statement report in Report Writer: on page 36).

2. Open the Toolbox if it isn’t already open.
(Layout >>Toolbox)
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10.

11.

12.

13.

14.

15.

16.

'l

In the report toolbox, select Calculated Fields from the drop-down
menu.

Choose New. The Calculated Field Definition window will open.

Enter a name for the field you wish to add.

Select the result type. If you’re adding SOP_User_Defined_Date_1 or
2, select Date. If you’re adding a Markdown Amount, select Currency.
For all the others, select String.

Choose the Functions tab.

Mark the User-defined radio button.

Select System from the Core drop-down list.

Select the function you wish to add. Refer to the chart prior to this
procedure for a list of available functions.

Select Add.

Choose the Fields tab.

From the Resources drop-down list, choose a file that includes the field
you wish to add. Refer to the chart prior to this procedure for a listing
of the applicable resources.

Select the field you wish to add and choose Add. Repeat this step to
add any additional fields. Refer to the chart prior to this procedure to
determine the applicable fields.

Select OK.

Drag the calculated field onto your report.

To prevent zero balances being printed, double-click the field after you drag it
into the report and select the Hide When Empty display option.

Setting security access for modified reports

If you modify a statement report, you will have to set security access on
the modified report in order to see your changes.
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To set security access for the modified report for each company:

1. Open the Alternate/Modified Forms and Reports window.
(Microsoft Dynamics GP Menu >> Tools >> Setup >> System >>
Alternate/Modified Forms and Reports)

B Alternate/Modified Forms and Reports E]@@
File  Edit Tools View Help sa Fabrikam, Inc, 4/12/2017
H Save | A& Clear | K Delete | Copy | 5
ID: [
Description: |
Product: Al Products v
Type: hd

Alternate/Modified Forms and Reports List:

2. Create or select an ID to which you want to grant access.
3. Choose Enhanced Customer Statement from the Product list.
4. Choose Reports from the Type list.

5. Highlight and expand the module for your modified report. Enure that
the modified report option is marked.

6. Select Save to save your changes.
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7. Open the User Security Setup window.
(Microsoft Dynamics GP Menu >> Tools >> Setup >> System >> User

Security).
B User Security Setup E]@@
File  Edit Tools Help sa Fabrikam, Inc, 4/12/2017
EH Save | A Clear | | 5
User: |Q|
Company hd
Foles:
Security Role I0 Mame

8. Select the user that you want to provide access to the modified report.

9. Choose the company for which the user needs access to the modified
report.
Ensure that the correct Alternate/Modified Forms and Reports ID is

displayed in the Alternate/Modified Forms and Reports ID field at the
bottom of the window.

B User Security Setup

FIEN Edit Tools  Help sa Fabrikam, Inc, 4/12/2017
H Save | & Clear | Copy 5
Uszer:
Company
Foles:

Security Role I Mame S
D Ad CLERK* Analytical Accounting clerk _
D Al MANAGER* Analytical Accounting manager
D ACCOUNTING MANAGER™ Accounting Manager
D AP CLERK* Account Payables Clerk
D AR CLERK* Account Receivables Clerk,

[ BookkeEPER* Baokkesper =
AlternateModified Forms and Reports 10: DEFAULTUSER A |
AFA Reports
@

10. Find and mark the appropriate Security Role ID.

11. Select Save to save your changes. Changes will not take affect until you
log out and back in to Microsoft Dynamics GP.
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APPENDIX A

DATA TABLES

The following chart lists all related data tables created in Enhanced

Customer Statement and their descriptions.

Sales Series

Display Name Technical Name Physical Name Description
BU_Error_Status BU_Error_Status BU448F04 Stores errors logged during
the generate statement
process to be printed on the
Statement Validation Report
BU RM Statements Header BU_RM_Statements_HDR BU44702 Stores archived statement
Archive header information
BU RM Statements Options BU_RM_Statements_ROPT BU40501 Stores the reporting options
for all Statement IDs
BU RM Statements Transactions | BU_RM_Statements_TRX BU44703 Stores archived statement
Archive detail information
BU_Statement_SETP BU_Statement_SETP BU44701 Stores general ECS control
information—currently only
used to track archive
numbers
ME_Invoices_on_Summary_ ME_Invoices_on_Summary_ ME44706 Stores the invoices that are
Exclude Exclude to be excluded from
summary statements
ME_Invoices_on_Summary_ ME_Invoices_on_Summary_ MEA44705 Stores history invoices for
HIST HIST processing summary
statements
ME_Invoices_on_Summary_ ME_Invoices_on_Summary_ ME44704 Stores open invoices for
OPEN OPEN processing summary
statements
ME_Statement_Summary_ ME_Statement_Summary_ ME44708 Stores statement summary
Messages Messages messages
ME_Statement_Summary_ ME_Statement_Summary_ ME44707 Stores statement summary

Options

Options

options
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